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End User Licence Agreement

Software Licence Agreement for Aspect

1. GRANT OF LICENCE: Subject to the terms below, Loomer hereby grants you a non-
exclusive, non-transferable licence to install and to use Aspect ('Software'). Under this 
licence, you may: (i) install and use the Software for your personal, internal use (ii) copy the 
Software for back-up or archival purposes; (iii) use an unregistered or evaluation version of 
the Software for evaluation purposes only. (iv) You may not distribute the software to others 
without first obtaining the required licences, where applicable. Whether you are licensing the 
Software as an individual or on behalf of an entity, you may not: (i) reverse engineer, 
decompile, or disassemble the Software or attempt to discover the source code; (ii) modify, 
or create derivative works based upon, the Software in whole or in part without the express 
written consent of Loomer; (iii) distribute copies of the Software; (iv) remove any proprietary 
notices or labels on the Software; (v) resell, lease, rent, transfer, sublicense, or otherwise 
transfer rights to the Software; By installing, copying, or using the Software, you (either on 
behalf of yourself as an individual or on behalf of an entity as its authorized representative) 
agree to all the terms of this End User Licence Agreement ('Agreement') regarding your use 
of the software. If you do not agree with all the terms of this Agreement, you may not use the 
Software.

2. ASPECT: You acknowledge that no title to the intellectual property in the Software is 
transferred to you. Title, ownership, rights, and intellectual property rights in and to the 
Software shall remain that of Loomer . The Software is protected by copyright laws and 
international treaty provisions. 

3. DISCLAIMER OF WARRANTY: You agree that Loomer has made no express warranties, 
oral or written, to you regarding the product and that the products are being provided to you 
'as is' without warranty of any kind. Loomer disclaims any and all other warranties, whether 
expressed, implied, or statutory. Loomer shall not be liable for indirect, incident, special, 
cover, reliance, or consequential damages resulting from the user of this product.

4. LIMITATION OF LIABILITY: You use this program solely at your own risk. In no event shall 
Loomer be liable to you for any damage, including but not limited to any loss, or other 
incidental, indirect or consequential damages of any kind arising out of the use of the 
software, even if Loomer has been advised of the possibility of such damages. In no event 
will Loomer be liable for any claim, whether in contract, tort, or any other theory of liability, 
exceed the cost of the software. This limitation shall apply to claims of personal injury to the 
extent permitted by law.

5. TERMINATION: This Agreement shall terminate automatically if you fail to comply with the 
limitations described in this Agreement. No notice shall be required to effectuate such 
termination. Upon termination, you must remove and destroy all copies of the Software. 

End User Licence Agreement
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6. MISCELLANEOUS: In the event of invalidity of any provision of this Agreement, the parties 
agree that such invalidity shall not affect the validity of the remaining portions of this 
Agreement. You agree that this is the entire agreement between you and Loomer, which 
supersedes any prior agreement, whether written or oral, and all other communications 
between Loomer and you relating to the subject matter of this Agreement. 

Reservation of rights.  
'VST' is a trademark of Steinberg Soft - und Hardware GmbH. All other trademarks are the 
property of their respective owners.
All rights not expressly granted in this Agreement are reserved by Loomer.

End User Licence Agreement
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Credits

Development Credits 

Aspect © 2009 Loomer

Developed by	 Loomer
Interface by 	 	 Kevin Barry @ www.inquer.co.uk

Tested by	 	 Clifton Cameron
	 	 	 kuniklo
	 	 	 Scott Simons (rexlapin)
	 	 	 taoyoyo

VST PlugIn Technology by Steinberg Media Technologies GmbH. This software is based in 
part on libpng, zlib, and JUCE.

Credits
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Requirements

Mac OS X requirements

• Requires Mac OS X v. 10.4 or later
• Intel x86 based processor 1.0Ghz, or above, with SSE

or
• PPC based processor 1.0Ghz, or above
• 512 MB RAM

Windows requirements

• Windows XP or Windows Vista, or above
• Intel x86 based processor 1.0Ghz, or above, with SSE
• 512 MB RAM

Linux requirements

• Intel x86 based processor 1.0Ghz, or above, with SSE
• 512 MB RAM

The following shared object libraries are required:

• libfreetype
• libasound
• libjack
• libXinerama

Requirements
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Aspect Overview

What is Aspect?

Aspect is a 32 note polyphonic software instrument that combines a great-sounding, 
powerful synthesis engine, with a flexible semi-modular architecture and unparalleled ease of 
use. 

The core of Aspect's superb sound are two analog modeled oscillators, each capable of 
producing a powerful selection of raw waveforms, and dual filters that can be routed in 
series, in parallel, or even blended into unique combinations. 

Modulation sources comes in the form of three analog modeled envelopes, capable of 
producing quick, snappy attacks, and three flexible LFOs, which can be synced to tempo.

A flexible patch section allows sources to be combined and processed to produce complex 
modulations from simple sources, whilst a versatile modulation architecture allows practically 
anything to be used as a modulation source and destination.

With optimized audio algorithms that won't overload your processor, rock-solid stability, and 
easy integration with any MIDI hardware controller, Resound is ideal for live work. With a 
simple and intuitive interface, flexible Bank and Program management, and total parameter 
automation, Resound fits right into your studio environment.

Plug-in vs Standalone

Depending upon your individual studio setup, Aspect can either be used as a plug-in 
component of a host application, or as a standalone application requiring no other 
dependencies. Generally, by using the host application's routing flexibility, running as a plug-
in allows easier integration with existing plug-in effects and instruments. If this integration is 
not required, the standalone version, without the extra layer of complexity added by the host 
consuming resources, performs slightly better. 

Bank and Program information, as well as MIDI Mapping assignments, are identical in both 
standalone and plug-in versions. This means any sounds created in one format can be 
opened in the other. 

Aspect Overview
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Aspect formats

For the Mac, the following formats are provided:

• Standalone Application
• Audio Unit (AU) Plug-In
• VST Plug-in
• RTAS Plug-In

These formats are available for Windows PC:

• Standalone Application
• VST Plug-in
• RTAS Plug-In

Linux have the following formats:

• Standalone Application
• VST Plug-in

Supported channel configurations

For maximum flexibility, Aspect can be used in several possible output channel 
configurations. The following configurations are possible:

• mono output
• stereo output

Note that some host applications may not support one or more of these configurations; 
consult your host's documentation for further details.

Aspect Overview
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Installation and Registration

Mac OS X installation

1. Start the installation process by double-clicking the Aspect installer application.
2. Read the introduction screen dialog text. Press Continue when you are ready to 

proceed.
3. Read the Licence Agreement. Click Continue, then Agree to confirm you have read and 

agree to the licence terms.
4. Select a destination volume into which to install Aspect, and then click Continue. 
5. From the list of installable components, uncheck any formats that you do not wish to 

install. Click Continue to proceed.
6. To complete the installation, press Install. 

The components are, by default, installed into the following directories:

• VST plug-in into /Library/Audio/Plug-Ins/VST
• Audio Unit plug-in into /Library/Audio/Plug-Ins/Components
• RTAS plug-in into /Library/Application Support/Digidesign/Plug-Ins
• Standalone application into /Applications
• Documentation into /Library/Documentation
• Default Bank into /Library/Application Support 

Windows installation

1. Start the installation process by double-clicking the Aspect installer application, 
Setup.exe. 

2. Read the welcome screen dialog text. Press Next when you are ready to continue.
3. Read the Licence Agreement. Click I Agree to confirm that you have read and agree to it.
4. From the list of installable components, uncheck any formats that you do not wish to 

install. Click Next to continue. 
5. If you have chosen to include the VST plug-in format, select the directory into which it will 

install. Click Next to continue.
6. Select a directory into which the common files will install. The user documentation, default 

Bank, and the Standalone application (if selected in the the list of components), will be 
placed in this location. To complete the installation, press Install.  

Unless any other directories are selected during the installation, the components are installed 
into the following directories:

• VST plug-in into the VST plug-ins folder, which is, unless configured otherwise, 
C:\Program Files\Steinberg\VSTPlugins\

• RTAS plug-in into C:\Program Files\Common Files\Digidesign\DAE\Plug-Ins\
• Standalone application, documentation and default Bank into C:\Program Files\Loomer

\Aspect

Installation and Registration
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Linux installation

Aspect for Linux is distributed as a standard Linux tarball. To install, extract the package 
using any unarchiving utility; the following command-line invocation will suffice:

 tar xzvf Aspect.tar.gz 

If you have a Linux VST host and have configured your VST Path, the VST plug-in can be 
moved into the required directory with the following commands:

 cd Aspect
 mv AspectVST.so $VST_PATH

Without the VST Path configured, you will need to ensure that your host uses the Aspect 
directory when searching for VSTs; consult your host's documentation for information on how 
to do this.

Aspect requires the following shared object libraries to be installed:

• libfreetype
• libasound
• libjack
• libXinerama

Without these libraries installed, the application will not launch. Install the libraries using your 
distribution's particular package management system, such as apt-get; consult your Linux 
distribution documentation for more information.

Product registration

Having installed Aspect, it will run in evaluation mode with the following limitations:

• User created Program and Bank configurations can be saved, but not loaded.
• Audio output will stop after 30 minutes of continuous use. The only way to continue 

using Aspect is to restart the application.

These limitations can be removed by purchasing a licence and registering your licence 
information into the product. Note that registering Aspect on a particular machine will remove 
the evaluation limitations for all Aspect plug-in formats installed on this machine; you don't 
need to individually register all plug-in formats. Licence information will be in the form of a 
user name and licence key. 

Installation and Registration
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To purchase a Aspect licence:

1. Launch Aspect. This can be either the standalone application, or as a plug-in.
2. From the Options menu, choose Purchase Aspect Licence. This will launch the shop 

website, from where a Aspect Licence can be purchased by clicking Add To Cart, 
followed by Checkout. Follow the on-screen prompts to enter your payment details and 
confirm your purchase.

3. Once you have purchased Aspect, you will receive your licence key information via email. 
It is important to keep this information safe because you will require the licence key if you 
ever need to reinstall and re-register Aspect. 

To register your copy of Aspect:

1. Choose Enter Aspect Licence from the Options menu.
2. Enter your name in the Name field. This must match exactly the name that was used to 

purchase your Aspect licence, including capitalization of letters.
3. Enter your licence key in the Licence Key field. This must match exactly the licence that 

you received when you purchased Aspect, including any hyphens.
4. Press OK to confirm that your name and corresponding licence key have been entered. 

You will be informed that the application must be restarted in order for registration 
changes to take effect. If you are currently running the standalone application, close and 
relaunch it. If Aspect is currently running as a plug-in, remove it from the host and add a 
new instance of it.

5. Aspect should now be registered. If the label on the bottom of the interface still reads 
Unregistered Evaluation, you must have entered the licence information incorrectly. Go 
back to step 1, paying careful attention that the name and licence key entered match 
exactly the licence information in the registration email.

Installation and Registration
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Audio and MIDI Configuration

Setup Audio and MIDI

When running Aspect as a Standalone application, you will need to setup your audio and 
MIDI interfaces. Note that when running as a plug-in, audio and MIDI routing is provided by 
the hosting application; consult the host's documentation for details. To open the Audio & 
MIDI Configuration dialog, select Audio & MIDI Configuration under the Options menu. 

The following dialog will be displayed:

From this dialog, the following details of your Audio and MIDI setup can be configured:

• Audio Device. Select the Audio Device you want to use from the list of available devices. 
Certain devices tend to perform better than others, so if multiple devices are available, you 
should favour: on Mac, using Core Audio; on Windows, using ASIO; on Linux, using JACK.

• Sample Rate. The Sample Rate dictates the overall quality of the audio output. Using a  
lower Sample Rate will reduce the presence of high-frequency components. Higher Sample 
Rates should therefore be preferred. However, be aware that the CPU Usage is directly 
proportional to the Sample Rate. A good compromise between quality and CPU Usage is 
44100Hz, which is the Sample Rate of CD audio. Select the Sample Rate you require from 
the available list.

Audio and MIDI Configuration
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• Audio Buffer Size. The Audio Buffer Size governs latency; a smaller buffer means that 
Aspect will respond more quickly to MIDI messages and Parameter changes. However, a 
smaller Audio Buffer Size will require more CPU Usage. Select the required Audio Buffer 
Size from the available list. Using too small of an Audio Buffer can overload your computer 
to the extent that audible clicks are heard. In this case, increase the Audio Buffer Size until 
clicks are no longer present..

• MIDI Inputs. Check any MIDI Input devices that you want to use with Aspect. 

Audio and MIDI Configuration
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Program Management

Parameters, Programs and Bank

You can modify the audio output that Aspect produces by setting the value of Parameters. 
Each Parameter, such as Delay Time, Feedback, or Highpass, will affect a specific element of 
the sound. The state of all Parameters are collectively called a Program. Programs are given a 
suitable name, displayed in the Menu Bar, to describe the sound they produce. 

Programs are grouped together into a Bank. You can only load a single Bank at a time. 
Although there is no requirement or limitation on how Programs are grouped, it is often useful 
to collect related Programs together, for example: a Bank of percussion sounds, a Bank 
containing sounds required to perform a specific set-list. 

Selecting Programs within a Bank

There are several ways of selecting a Program within a Bank:

• Menu Bar Previous and Next Controls. If you wish to browse quickly through all the 
Programs within a Bank, you can do so using the the Previous and Next controls. 

• Program Select Control. The Program Select Control will display a list of all programs 
contained  within a Bank. The required program can be selected from this list.  

• Program Change MIDI Messages. You can change programs by using MIDI Program 
Change commands. This requires a MIDI keyboard or a control surface with the ability to 
send MIDI Program Change commands; consult your controller’s documentation for details. 
If using Aspect as a plug-in, this functionality is dependent upon the host correctly 
forwarding MIDI messages to the plug-in; check the documentation provided with your host 
for details.

• Host Application Program Management. If Aspect is being used as a plug-in, the host 
may provide a mechanism to change the currently selected Program. The operation of this 
is entirely host dependent, and varies greatly from host to host; check the documentation 
provided with your host for details

Program Management
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File Management

If you wish to keep any changes to a Program, it will need to be stored in the current Bank. A 
program that needs storing is marked by an asterisk (*) suffix beside its name. Any changes 
will be lost if you change the currently selected Program without first storing it. The steps 
required to store a Program depend upon where you want to save it:

• To store the Program changes over the current version of itself in the bank:

1. Click Store. Notice that the asterisk disappears, indicating that the Program no 
longer has any outstanding changes that require storing.

• To store the Program changes to a different position in the Bank:

1. Click Store To. All the Programs within the Bank will be displayed in a list. 
2. Click on the required Program to overwrite it. Notice that the asterisk disappears, 

indicating that the Program no longer has changes that require storing, and that the 
newly stored Program is now selected.

To permanently keep Banks and Programs you have created, you will need to save them as 
files. Banks can be saved in their entirety, or you can save individual Programs from within a 
Bank. When Aspect is closed, any unsaved changes to a Bank will be lost. 

To save an entire Bank to a file:

1. Under the File menu, choose Save Bank...
2. Choose a location and enter a filename for the Bank.

To save a Program to a file:

1. Select the Program you want to save
2. Under the File menu, choose Save Program...
3. Choose a location and enter a filename for the Program.

To load a saved Bank from a file:

1. Under the File menu, choose Open... 
2. Browse to the location and select the required Bank file.

Program Management
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To load a saved Program from a file:

1. Decide where in the Bank you want the Program to be loaded.
2. Select this Program.
3. Under the File menu, choose Open...
4. Browse to the location and select the required Program file

Create a new Bank

Select New Bank, under the File menu, to create a new Bank. All Programs within the Bank 
will be in their initialized state.

Create a new Program

Select New Program, under the File menu, to create a new Program. This Program will be 
in its initialized state.

Compare a changed Program to the original Program

Often you’ll want to compare a Program that you have amended to see if it is is actually an 
improvement on the original. Pressing the A | B button temporarily reverts a changed 
Program back to its original state. Pressing the A | B button a second time returns to the 
changed Program. This method allows you to easily contrast the Program changes you have 
made to the original Program.

Program Management
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MIDI Controller Mapping

MIDI controllers

Instead of configuring a Program using a mouse, you can change any Parameter values 
using a MIDI keyboard or a control surface. This is done by mapping each Parameter to a 
MIDI Continuous Controller (CC). A Parameter can only be mapped to a single MIDI 
controller; the same MIDI control can, however, be mapped to several different Parameters.  

MIDI Controller mappings are global; once defined, the same mapping assignments will be 
used by all Aspect Programs. This means that you only need define mappings once for your 
particular controller.

Display current MIDI controller mappings

To view the current MIDI controller mappings:

1. Enter MIDI Learn Mode by choosing Start MIDI Learn under the Options menu. Each 
Parameter's mapped MIDI controller will now be displayed beside it in yellow text. 
Parameters without any mapping will be labelled -.  

2. When you have finished viewing the MIDI controller mappings, choose Stop MIDI Learn 
under the Options menu. 

Assign MIDI controllers to controls

To map a MIDI controller to a Parameter:

1. Enter MIDI Learn Mode by choosing Start MIDI Learn under the Options menu. 
2. Click on the Parameter you wish to map to a MIDI controller.
3. Turn your MIDI controller. The Parameter should now be labelled with the MIDI CC 

number of this controller. 
4. You can now either:

• Map another Parameter by repeating these steps from Step 2.
• Finish mapping Parameters by choosing Stop MIDI Learn under the Options menu.

MIDI Controller Mapping
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Remove MIDI controller mappings from controls

To remove a mapped  MIDI controller from a Parameter:

1. Enter MIDI Learn Mode by choosing Start MIDI Learn under the Options menu. 
2. Click on the Parameter from which you wish to remove the mapping. This Parameter will 

become unmapped, and the CC number label on the Parameter will disappear to reflect 
this.

3. You can now either:

• Remove the mapping from another Parameter by repeating these steps from Step 2.
• Finish removing Parameter mappings by choosing Stop MIDI Learn under the 

Options menu.

MIDI Controller Mapping
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Using Aspect

Aspect can either be used a Standalone application, or as a plug-in. When used as a plug-in 
effect, Aspect is placed directly in a host instrument channel. Consult your host's 
documentation to find out how to add a plug-in instrument. 

Modulations

Each section has a number of Parameters that can be modulated (varied in real-time), by any 
of the modulation sources. Parameters that can be modulated are identified by having 
Modulation Slots: 

Each Parameter's slots allows for up to three modulation sources to be used (although, if 
required, more than three can be used by summing several modulation sources into a single 
one using the Patch Section's Adder component, and using the Adder's summed output as 
a source). To select which slot is currently visible, click on either View Slot 1 Button, View 
Slot 2 Button or View Slot 3 Button. To select the source for the currently visible slot, click 
on the Source Combo and choose the required modulation source from the visible list. As 
well as a source, each modulation has a Depth control. This depth governs how much the 
modulation source changes the Parameters: at small depth values, the modulation affects 
only small Parameter changes; at larger values, the modulation source causes much more 
pronounced changes. 

The following modulation sources are available:

• Selecting Off disables this modulation slot

• Using Note Pitch as a modulation source allows a Parameter to follow the pitch of the 
currently playing MIDI note. Because in most cases you will expect the audio oscillators to 
correspond to the playing note, assigning Note Pitch to Oscillator Pitch is a very common 
configuration. Note Pitch is also often used to modulate a filter's cutoff, ensuring that the 
filter follows the playing note.

Using Aspect
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• The Velocity modulation source corresponds to how hard the playing note is struck. This is 
often used to modulate the Amplifier, meaning that the harder a note is struck, the louder it 
gets.

• As well as producing the raw audio signal, Oscillator 1 and Oscillator 2 can also be used 
a modulation source. This can, amongst other uses, be used to generate FM (Frequency 
Modulation) sounds, wherein Oscillator 1 can be used to modulate the pitch of Oscillator 2.

• Choosing Noise allows the white noise audio signal to be used as a modulation source.

• Envelope 1, Envelope 2 and Envelope 3 can be used as a modulation source. Note that, 
although it can additionally be assigned other modulation duties, Envelope 1 will always 
modulate the Amplifier, and so will always be used to govern the overall sound level.

• LFO 1, LFO 2 and LFO 3 can be used as modulation sources.
• Selecting S&H uses the Sample & Hold output as a modulation source.

• Adder 1, Adder 2, Multiplier 1, Multiplier 2, Inverter 1, Inverter 2, and Lag Generator 
correspond to the modulation source outputs in the patch section.
 

• Select either Aftertouch, or Channel Pressure to use polyphonic (in the case of 
Aftertouch) or monophonic (in the case of Channel Pressure) aftertouch as a modulation 
source.

• The PitchBend modulation source corresponds to the Pitch Bend control on a MIDI 
keyboard or sequencer. Likewise, the ModWheel modulation source corresponds to the 
Modulation Wheel control.

• VoiceNumber corresponds to the number of the currently playing voice (1 to 32). When in 
monophonic (1 voice) mode, this will always be 1. This can be used to add subtle variation 
to individual voices.

• The Random modulation source produces a random number between -1 and 1 every time 
a new note begins, which will remain at the same value until this voice produces a new 
note. This can be use to add subtle variation to individual notes. 

• The UnisonDepth modulation source corresponds to the voice number within a group of 
unison notes. Variations in each note within a unison group can be produced by assigning 
UnisonDepth to any parameter (for example, assigning it to Oscillator Pitch Modulation for a 
classic thick unison sound.)

Global Section

The Global Section contains master controls for the Program:

Using Aspect
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• The Master Volume Parameter controls the overall sound output level. A meter provides a 
visual cue to the current level: the louder the output, the higher the meter will register. Too 
loud of an output will produce digital clipping, a usually undesirable form of distortion. When 
this occurs, the meter will display a red warning indicator. Click the meter to reset the 
warning display. 

• The Glissando Parameter controls the time taken for a note to slide from one pitch to the 
next. The pitch transitions are instant when Glissando is set to 0%, but will become slower 
and more prominent as the Glissando percent increases. When Always Glide is turned off, 
glissando will only affect notes that are currently playing. With it turned on, glissando will 
affect every note.

• The Polyphony Parameter specifies the maximum number of voices that can be heard 
simultaneously. Polyphony can range from 1 to 32. Select 1 voice to use Aspect as a 
monophonic synthesizer. 

• The Unison Parameter controls the number of voices that will be allocated to each note, 
from 1 (Unison Off), to 5. The Polyphony Parameter must be equal to or greater than the 
Unison Parameter in order for the required number of Unison voices to be heard. In order to 
produce variations within the voices within the Unison group, the UnisonDepth modulation 
source should be allocated to one or more parameters (such as Pitch or Pan Modulation).

Oscillator Section

The Oscillators are the basic sound sources in Aspect. They produce raw periodic waveforms 
which can be manipulated with filters and envelopes or modulated from a variety of sources 
into complex, dynamic timbres. Oscillators are controlled using the following parameters:

• The Shape Parameter decides which waveform shape the oscillator will produce. Each 
shape has its own sound, and certain waveform shapes are more appropriate for certain 
sounds than others. The possible waveform shapes are: The Sawtooth waveform (so 
called because it resembles the teeth on a saw) produces a rich, full sound; The Pulse 
waveform is a flexible shape that can produce a range of sounds, from hollow and reedy, to 
harsh and buzzing. Its tonal range arises from the technique of changing the shape's pulse-
width: a pulse-width of 50% produces a reedy square wave; increasing or decreasing the 
pulse-width beyond this produces a more buzzy tone; The Triangle waveforms makes a 
smooth, rounded sound, resembling that of an organ; The Sine waveform produces a pure, 
fine, tone.

• The basic pitch of the oscillator is set by the Octave, Transpose, and Detune Parameters. 
The Octave Parameter is used to shift the pitch up or down by entire Octaves (12 
semitones). Choose 1, 2, or 3 to shift the pitch up by that number of octaves. Choose -1, 
-2, or -3 to shift the pitch down. Choose 0 if you require no octave shifting.
 

Using Aspect
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• The Transpose Parameter allows the pitch to be shifted by semitone increments. Choose 
between 1 and 12 to shift the pitch up by that number of semitones, or between -1 and -12 
to shift down. A Transpose of 0 provides no transposition.

• The Detune Parameter allows for the smallest of changes to pitch by tuning up and down 
by mere cents (one hundredth of a semitone). Choose between 1 and 50 to tune the pitch 
up by that number of cents, or between -1 and -50 to tune down, or 0 to use no detuning. 
Playing both oscillators together, but detuning one by several cents produces a classic 'fat' 
synth sound. 

• When the Sync Parameter (which is available only on Oscillator 2) is switched on, the pitch 
of Oscillator 2 will follow that of Oscillator 1 (restarting Oscillator 2's waveform period when 
Oscillator 1's waveform completes a period). This produces timbres more complex than is 
possible to synthesize with a single oscillator. 

• Each Oscillator also has three Pitch Modulation Slots to allow the pitch to be varied. The 
most widely used Oscillator pitch modulation source is Note Pitch. When the Oscillator is 
modulated by Note Pitch, it will track any MIDI notes and the Oscillator pitch will match the 
MIDI note pitch. In most cases, the Note Pitch modulation depth should be set to maximum 
(64 semitones) in order to exactly track the MIDI notes. 

• The Pulse-width Parameter only has any effect when the oscillator shape is set to Pulse. 
This Parameter will then govern the width of the oscillator's output. The pulse-width can 
also be modulated using the three Pulse-width Modulation Slots.

Mixer Section

The Mixer section is used to combine Oscillator 1, Oscillator 2, and the Noise source into a 
single audio stream. The relative balance of each component can be altered using the 
Oscillator 1 Volume, Oscillator 2 Volume, and Noise Volume Parameters. Each volume 
Parameter will have a value between 0% and 100%: at 0%, the component is completely 
removed from the audio; at 100%, the component volume is at a maximum. If required, the 
Mixer section can be bypassed entirely by routing the Oscillators and Noise sources directly 
to the Filter inputs.

Filter Section

A Filter is one of the primary tools for sound design available to synthesizers. The Filter 
Section changes the raw Oscillator timbre by reducing the amplitude of some frequencies, 
whilst allowing other frequencies through unattenuated. The Cutoff frequency marks the 
crossover point between attenuated and unattenuated areas. When using a Lowpass filter, 
frequencies below the Cutoff are unaffected, whilst those above are reduced; a Highpass filter 
attenuates frequencies below the cutoff, but allows those above to pass through without 
change; finally, a Bandpass filter allows a small band of frequencies around the Cutoff to pass 
through unattenuated, but diminishes all frequencies outside this band.
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• The Input Parameter controls which audio source to use as an input into the Filter. 

• Use the Type Parameter to choose which type of Filter this will be, from Lowpass, 
Bandpass, or Highpass.

• The Cutoff Parameter controls the frequency at which crossover occurs. This can be 
modulated using the Cutoff Modulation Slots. If you want the cutoff to track the pitch of 
the note being played, assign Note Pitch as a modulation source. 

• The Resonance Parameter produces an accent in frequencies around the Cutoff 
frequency. Resonance is express as a percentage: at 0%, no cutoff boost is perceived, 
whilst at 100% there is a massive amplification around the cutoff. 

Output Section

• The Filter Mix Parameter controls the relative output of Filter 1 and Filter 2: at 0%, only 
Filter 1 is heard; at 50%, both Filter 1 and Filter 2 are mixed in equal proportions; at 100%, 
only Filter 2 is heard. This Parameter can also be modulated using a modulation matrix. 
Using this Parameter in conjunction with the Filter input will enable Aspect Filters to run in 
either series or parallel:

When filters are used in Series, the output produced when the audio input runs through 
Filter 1, is then processed by Filter 2. To use this configuration, enable Filter 2 and use Filter 
1 as its input. The Output Mixer should be set to 100% so that only Filter 2's output is 
heard. 

When filters are 
used in Parallel, the audio input is processed by both Filter 1 and Filter 2, and then 
recombined into an audio signal that is the sum of both Filter's outputs. To use this 
configuration, enable Filter 2 and ensure that it has the same input as Filter 1. The Output 
Mixer should be set to 50% to ensure that both Filter's output signals are present.
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Note that due to Aspect’s flexible architecture, hybrid combinations of series and parallel 
filters are also possible. 

• The Pan Parameter allows the signal to be placed in the stereo panorama. Choose C to 
keep the signal centered, L1% to L100% to place the signal to the left (where L1% is 
slightly left of centre, and L100% is to the extreme left). Use R%1 to R100% to place the 
signal to the right (where R1% is slightly right of centre, and R100% is to the extreme right). 
This Parameter can also be modulated using the Pan Modulation Matrix.

• The Amplifier Modulation Slots are used to change the volume of a voice. Note that 
Envelope 1 is permanently connected to the Amplifier, and so will always govern the overall 
voice volume. The Modulation Matrix allows other source to also influence the volume, for 
example, using Velocity as a modulation source will produce a sound that is louder when 
the note is played with more velocity, and quieter when played at a lower velocity. 

Envelope Section

The Envelopes components (Envelope 1, Envelope 2 and Envelope 3) generate time-varying 
modulation sources. The Envelopes are controlled by note-on and note-off events. If a note-
on is received, the Envelope will start from the Attack stage and progress onto the Decay, 
and Sustain stages. A note-off event, regardless of the current envelope stage, will move 
onto the Release stage. 

• The Attack Parameter, measured in milliseconds, controls how quickly the modulation 
output reaches its peak. At smaller values, the envelope output reaches the maximum value 
almost instantly. At larger values, the envelope output slowly and gently increases over a 
longer period of time until the peak is reached. 
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• The Decay Parameter, specified in milliseconds, controls how quickly the modulation 
output falls from the peak value (reached during the attack stage) to the sustain value. Short 
values cause a quick fall; longer values cause a slower descent. 

• The Sustain Parameter, expressed as a percentage, specifies the steady-state level. The 
envelope will remain in this stage as long as a note is held. 

• The Release Parameter, specified in milliseconds, controls how quickly the modulation 
output falls from the current value to zero. Short values cause a quick fall; longer values 
cause a slower descent. 

Whilst each Envelope can be used as a modulation source for any component, there is a 
hard-wired connection (which cannot be removed) from Envelope 1 to the Amplifier. Envelope 
1 can additionally be used as a modulation source for any other components; it will however 
always still control the voice's amplitude.

LFO Section

A Low Frequency Oscillator (LFO) produces simple waveform shapes, similar to the output of 
the main Aspect oscillators. The difference, however, between the LFO and Audio Oscillators 
is in the pitch of these waveforms; LFOs, as their name suggest, produce a waveform at a 
much lower frequency. Because the LFO signal is too low a frequency to be audible, they are 
usually not routed into the main sound output, but instead used as modulation sources. 

• The LFO Shape Parameter, which can be set to Sine, Triangle, Square, or Sawtooth, 
controls the shape of the LFO waveform.

• An LFO can be made to synchronize itself with a the host's tempo by switching the LFO 
Tempo Sync Parameter on. When the LFO is synced, its period is based upon musical 
subdivisions. Without syncing, the period is expressed as a value in Hz. A non-synced LFO 
period can also be modulated with the three LFO modulation slots.

The Time Parameter controls the LFO frequency. This is expressed in Hz (cycles per second) 
when sync is disabled, and in musical note subdivisions when sync is enabled.

Patch Section

• The Inverter components (Inverter 1 and Inverter 2), each take a modulation source and 
produce a flipped version. For example, using an envelope modulation source that usually 
increases to a positive maximum during the attack phase, will instead produce a signal that 
decreases to a negative minimum during the attack phase.

• The Adder components, Adder 1 and Adder 2, both take two modulation sources and 
produce an output that is equal to the sum of the inputs. 
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• The Multiplier components, Multiplier 1 and Multiplier 2, both take two modulation 
sources and produce an output that is equal to the product of the inputs. This is particularly 
useful for producing scaled modulation sources: for example, assigning both LFO 1 and the 
Mod Wheel to a multiplier produces an LFO output, with which the depth can be controlled 
with the Mod Wheel. 

• The purpose of the Sample and Hold (S&H) component is to hold a modulation source's 
value steady for a short time. The component takes two inputs, a Source and Clock; 
whenever the Clock input source changes from a negative to a positive value (known as a 
zero-crossing), the current value of the input source will be taken, output, and held steady 
until the next zero-crossing. 

• The Lag Generator slews the input modulation source, producing a portamento type 
effect and reducing the speed of changes. The Lag Parameter affects how much the input 
is slewed: at 0%, the input source passes through unaltered, whilst at higher values the 
slewing is more pronounced.

Backward Compatibility

From Aspect 1.5, the oscillator algorithms have been improved to reduce CPU usage, 
remove aliasing at extreme frequencies, and improve the overall sound. By default, the new 
oscillators are enabled.

If perfect compatibility with previously created presets is required, the previous oscillators can 
be used instead. To return to the previous oscillators, enable the Legacy Oscillators option 
under the Backwards Compatibility Options. A restart of Aspect is required for changes to 
the Backwards Compatibility options to take effect.

Backwards Compatibility options are only available to registered Aspect users.
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Control types

• Click on a rotary control and drag either upwards to increase the value, or downwards to 
decrease it. Hold down shift and drag to make smaller and more precise changes. Hold 
down ctrl and click to return the control to its default value. Rotary controls can also be 
changed by hovering the mouse cursor over the control and scrolling the mouse-wheel up 
or down.

• Click on a button control to toggle its value between On and Off. Hold down ctrl and click 
to return the control to its default value.

• Click on a combo control to display a list of possible values, from which the required value 
can be selected. Hold down ctrl and click to return the control to its default value. Combo 
controls can also be changed by hovering the mouse cursor over the control and scrolling 
the mouse-wheel up or down.
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Status Display

Status Display information is displayed at the bottom right area of the Aspect interface:

CPU Usage monitor

The CPU Usage monitor displays the percentage of processor resources dedicated to 
producing the audio output. The total processor resources on a computer are limited, so 
when Aspect increases its CPU usage, there will be less CPU resources remaining for other 
plug-ins and applications. CPU Usage will differ depending on which Program is currently 
loaded, how that particular Program is configured, and how many voices are being played. 

A value of 100% indicates that your computer is running at maximum capacity and will not 
have enough processing power remaining for anything else. You might notice audio output 
become temporarily glitchy, or that the user interface becomes sluggish. There are several 
methods for resolving this:

• Choose a different Program that has less CPU Usage.
• If running in Standalone mode, you can increase the latency or decrease the sample rate. 

See section Setup Audio & MIDI.
• Reduce the Polyphony or number of Unison voices in the current Program.
• If your host offers Freeze or Offline processing, you might be able to render the audio 

output in non-realtime. 

MIDI Input monitor

The MIDI Input monitor flickers to show that a MIDI Message has been received. You can use 
this to confirm that your MIDI controller is configured correctly for Aspect.
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Active Voices monitor

The Active Voices monitor displays the number of voices that are currently playing. 

Tempo control

The Tempo control only appears when running Aspect in Standalone mode; when running as 
a plug-in, the host application will provide the tempo for Aspect. The Tempo control displays 
the current Tempo, in beats per minute (bpm). It can be changed by either:

• Double-clicking the tempo control, typing the required bpm and pressing return.
• Clicking on the tempo control and dragging either upwards to increase the tempo, or 

downwards to decrease the tempo.
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